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СТВОРЕННЯ МУЗИКИ У СAKEWALK SONAR PLATINUM 
(Частина 3) 

 
Мета роботи. З’ясувати нові засоби та методи використання комп'ютерних технологій у сучасній музичній 

практиці на прикладі опису роботи та широких можливостей одного з наймогутніших музичних редакторів Cakewalk 

SONAR Platinum, Методологія дослідження. У статті використаний системний підхід, а також застосовані методи 

порівняння та узагальнення. Наукова новизна роботи полягає в розширенні можливостей композиторів, 

аранжувальників, звукорежисерів і початківців музикантів при створенні музики за допомогою одного з наймогутніших 

сучасних музичних редакторів Cakewalk SONAR Platinum. Висновки. Даний програмний продукт має можливості 

виконання повного циклу із запису, збереження, обробки, редагування, відтворенню цифрового саунду та зведення 

музики та відео. Cakewalk SONAR Platinum підходить як для домашніх студій, так і для Project-студій та 

багатоканальних комерційних систем звукозапису. Музичний звуковий редактор СAKEWALK SONAR PLATINUM 

це одна з передових робочих цифрових аудіо-станцій, що пропонує передові технології для творчих експериментів у 

створенні музики. 

Ключові слова: музичний звуковий редактор, озвучування, аранжування, зведення, мастеринг, композитор, 

звукорежисер. 
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Создание музики в Cakewalk SONAR Platinum (часть 3) 

Цель работы. Выяснить новые средства и методы использования компьютерных технологий в современной 

музыкальной практике на примере описания работы и широких возможностей одного из самых могущественных 

музыкальных редакторов Cakewalk SONAR Platinum, Методология исследования. В статье использован системный 

подход, а также применены методы сравнения и обобщения. Научная новизна работы заключается в расширении 

возможностей композиторов, аранжировщиков, звукорежиссеров и начинающих музыкантов при создании музыки с 

помощью одного из самых могучих современных музыкальных редакторов Cakewalk SONAR Platinum. Выводы. 

Данный программный продукт имеет возможности выполнения полного цикла из записи, сохранения, обработки, 

редактирования, воссозданию цифрового саунда и сведения музыки и видео. Cakewalk SONAR Platinum подходит как 

для домашних студий, так и для Project-студий и многоканальных коммерческих систем звукозаписи. Музыкальный 

звуковой редактор СAKEWALK SONAR PLATINUM это одна из передовых рабочих цифровых аудио-станций, что 

предлагает передовые технологии для творческих экспериментов в создании музыки. 

Ключевые слова: музыкальный звуковой редактор, озвучивание, аранжировка, сведение, мастеринг, 

композитор, звукорежиссер. 
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  Creating music at Cakewalk SONAR Platinum (part 3) 

Purpose of the article. To find out new facilities and methods of the use of computer technologies in modern musical 

practice on the example of the description of work and vast possibilities of one of the mightiest musical editors of Cakewalk 

SONAR Platinum. Methodology. The article uses a systematic approach, and also applies methods of comparison and 
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generalization. The scientific novelty of work consists of the expansion of possibilities of composers, arrangers, sound 

producers, and beginning musicians at the creation of music using one of the mightiest modern musical editors of Cakewalk 

SONAR Platinum. Conclusions. Working with a computer significantly reform the creative process of the composer, arranger, 

sound engineer, and his results. There are new forms of existence of musical works that are impossible without computer 

technology. It becomes a real computer music performance. All this requires an understanding of the science of music, the 

essence of these changes, their novelty, as well as the need to research modern music computer technology. This software 

product has possibilities of implementation of the complete cycle from a record, maintenance, treatment, editing, to the recreation 

of digital саунда and taking of music and video. Cakewalk SONAR Platinum benefits both for home studios and for Project- of 

studios and multichannel commercial systems of the audio recording. Musical voice editor СAKEWALK SONAR PLATINUM 

it one of the front-rank workers of the digital audio stations, that offers front-rank technologies for creative experiments in the 

creation of music. 

Key words: musical editor, wiring for sound, arrangement, taking, mastering, composer, sound producer. 

 

Робота з комп'ютером істотно реформує творчий процес композитора, аранжувальника, 

звукорежисера і його результати. Виникають нові форми існування музичних творів, що неможливі поза 

комп'ютерними технологіями. Стає реальним комп'ютерне музичне виконання. Все це вимагає осмислення 

музичною наукою суті даних змін, їх новизни, а також необхідності дослідження сучасних музичних 

комп'ютерних технологій. 

Виклад основного матеріалу. Продовжимо дослідження передових технології роботи у цифровій 

аудіо-станції У СAKEWALK SONAR PLATINUM. 

4. Режим нотного редактора (Staff). Для роботи з музичною партитурою в SONAR передбачено 

вікно нотного редактора Staff, в якому MIDI-ноти мають вид символів музичної нотації. В першу чергу, це 

вікно призначено для користувачів, що мають музичну освіту. В ньому доступний набір функцій для 

редакції і роздруку нотного матеріалу. Відкрити вікно можна за допомогою меню Views а Staff View або 

гарячими клавішами Alt + 6 (див. рис. 4.1). Основною панеллю для набору нот є інструментальна і панель 

прив'язки до сітки. Разом вони показані на рис.4.2. Назви елементів з 1 по 6 описані вище ( в ч.2 , рис. 3.15. 

Модуль інструментів). Елементи 7 - 9 будуть представлені нижче. 
 

 
 

Рис.4.1. Вікно нотного редактора  Рис.4.2. Панелі інструментальна та прив'язки до сітки 

 

Для набору ноти спочатку вибирається її тривалість. Для цього потрібно клацнути правою кнопкою 

мишки по елементу 8 (Event Draw Duration). Відкриється вікно (рис.4.3), в якому проводиться вибір 

необхідної тривалості ноти. 

 
Рис.4.3. Вікно вибору тривалості   Рис.4.4. Вікно прив'язки до сітки 

Далі включається кнопка Snap - прив'язки до сітки елемент 7, а правою кнопкою мишки 

відкриваються дані з вибору тривалості елемент 9 (рис. 4.4). Для вибору тріольної тривалості та тривалості з 



157 

Мистецтвознавчі записки Випуск 36 
 

 

 

крапкою вибираються відповідно елементи 10 і 11. В меню View а Display Resolution нотного редактора 

(рис. 4.5) вибирається мінімальна тривалість нот майбутньої партитури. 

Ноти  вводяться елементами          (1) або     (5). При їх виборі курсор мишки набуває вигляд 

олівця, клацаючи яким по нотоносцю і вводяться ноти. Положення олівця можна контролювати за 

допомогою покажчика, в якому відображається такт, частка, тики і нота (в нашому випадку 3.01.000 B5) - 3 - 

й такт, перша частка, нуль тиків і нота Сі п'ятої октави (рис.4.1). 

 

 
Рис.4.5. Вибір мінімальної тривалості 

 

Для видалення нот застосовується   (Erase Tool) - елемент  (6). Можна виділити ноти елементом 

Select Tool -   (2) і натискувати кнопку видалення Delete клавіатури. Копіювання нот проводиться за 

допомогою їх активації Select Tool, далі збереженням в буфері Ctrl + З і введенням Ctrl + V на місце, яке 

позначене курсором мишки. Переміщення положення курсору мишки по партитурі проводиться по лінійці 

тактів, що розташована вище за вікно партитури (рис.4.1). Переміщення нот вниз, вгору, вліво  управо 

можна  проводити  елементами ,   і   . Причому при першому і останньому елементі переміщення 

супроводжується звучанням, що відповідає положенню ноти. 

Для введення ноти із знаком альтерації потрібно кликнути по ній правою кнопкою мишки. 

Відкриється вікно Note Properties (рис.4.6) де   клацаючи мишкою в полі Pitch   по покажчиках    потрібно 

вибрати ноту, яку треба для змінити. Символи можуть виявитися енгармонійними, наприклад замість до  

дієз - ре бемоль, але з цим потрібно погодитися. 
Для зміни тривалості звучання ноти потрібно в полі Duration ввести кількість тиків. 

Для введення нового розміру, метра і тональності потрібно в меню Project вибрати Insert Meter 

Key/Change. Відкриється вікно рис.4.7. 

  
Рис. 4.6. Вікно Note Properties   Рис.4.7. Вікно зміни розміру, метра і тональності 

 

В полі At Measure вводиться номер такту, з якого треба провести зміну параметрів. В полях Beats 

реr Measure і Beat Value вибираються розмір і метр. У випадному списку Key Signature встановлюється 

необхідна тональність. Дії підтверджуються кнопкою "Ок". 

4.1. Додаткові дії в режимі Staff. Вище за партитуру над лінійкою тактів (рис.4.1) знаходяться 

елементи додаткових дій, а над ними меню режиму Staff (меню окремо на рис.4.8). 
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Рис.4.8. Елементи додаткових дій 

Меню Print призначене для роздрукування партитури. Там же її можна подивитися в готовому 

вигляді. При входженні в меню Edit відкриється вікно рис.4.9. 

Клацання по Layout відкриває вікно Staff View Layout (рис. 4.10). 
 

 

Рис.4.9. Вміст меню Edit Рис.4.10. Вікно Staff View Layout 

 

В полі Track вибирається необхідний для дій трек. В списку Clef відкривається випадне меню (рис. 

4.11), якому вибираються ключі - скрипкові, басові тощо. При виборі Percussion стає доступною вкладка 

Percussion Setting при активації якої відкривається вікно рис.4.12, в якому можна проводити різні дії з 

позначенням нотних головок ударних інструментів. 

  
Рис.4.11. Список вибору ключів   Рис.4.12. Коректування нотних головок ударних інструментів  

 

При виборі у випадному списку Clef - Treble/Bass в нотному вікні з'явиться два треки (один з 

скрипковимключем, інший з басовим), а поле Split стає активним і в ньому можна встановити ноту - 

роздільник треків (рис.4.13). За умовчанням вибрана С5 (до п'ятої октави). 

 
Рис.4.13. Установка басового і скрипкового треків 

При виборі в меню Edit (рис.4.9) рядку Play Previous звучатиме попередня від вибраного курсором 

нота, а при виборі Play Next - подальша. Меню Viev містить список команд (рис.4.14). Активацією 

команди Show/Hide Track Pane у вікні нотного редактора (рис.4.1) з'являється вікно треків (рис.4.15), в 

якому не виходячи з редактора можна включать/виключати кнопки заглушення, соло і запису. 
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Рис.4.14. Список команд меню View Рис.4.15. Вікно треків 

 

Вікно треків можна робити вужче або ширше, якщо схопити мишкою за лівий край. Якщо 

скористатися рядком Show/Hide Fret Pane, то внизу вікна нотного редактора з'являється гриф гітари 

(рис.4.16). Клацаючи мишкою по струнах і відповідних ладах можна створювати ноти безпосередньо на 

грифі. Меню Tracks містить вибір з трьох рядків (рис.4.17). 

  
Рис. 4.16. Набір нот в режимі гітари Рис.4.17. Вміст меню Tracks 

 

Верхній рядок відкриває вікно ( рис. 4.18), в якому вибираються треки, що необхідні  в даний 

момент для роботи. Рядком Show Next track вибирається наступний трек, а Show Previous Track 

вибирається попередній трек. 

 
 

Рис.4.18. Вікно вибору треків 

Розміри нотного тексту можна збільшувати/зменшувати елементами додаткових дій -1 (рис.4.8). 

Знаком плюс розмір робиться більше, мінус менше. При наведенні курсору мишки на стовпчик з'являється 

вертикальна двох направлена стрілка, при переміщенні якої вгору розмір партитури збільшується, а вниз - 

зменшується. 

Справа (рис.4.8) знаходяться елементи введення тексту (Lyrics), акордів (Chords), експресії 

(Expression), крещендо і педалі (Pedals). Для введення тексту потрібно вибрати інструмент (5) на панелі 

інструментів (рис.4.2). Потім активувати кнопку Lyrics, помістити курсор мишки під нотою і натискувати 

на цю область (рис.4.19). Для введення дефіса потрібно скористатися відповідною кнопкою клавіатури 

комп'ютера. Для переходу до наступної ноти без дефіса потрібно натискувати пропуск. Для виходу з 

режиму знову натискувати на Lyrics. 
 

Рис.4.19. Введення тексту 
Решта елементів вводиться аналогічно окрім введення акордів де після вибору елемента Chords 

потрібно помістити і натискувати курсор миші над нотою. З'явиться позначення акорду до - мажор. Якщо 

потрібен інший акорд об клацання по ньому правої кнопки миші відкриває вікно властивостей акордів 

Chord Properties (рис.4.20). 

В полі Name можна написати необхідне буквено-цифрове позначення акорду підтвердивши 

клавішею і відкрити випадний список акордів (рис.4.21), з якого вибрати той, який потрібно. 
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Рис.4.20. Вікно властивостей акордів   Рис.4.21. Список акордів 

 

Клавішею Play можна прослуховувати звучання вибраного акорду. Клавішею New Grid 

відкривається вікно, в якому можна задати нове розташування акорду (рис.4.22). 

 
                   Рис.4.22. Нове розташування акорду 

 

Якщо не потрібна сітка акорду, то потрібна скористатися клавішею Remove Grid. Стираються при 

необхідності введені елементи кнопкою видалення Erase (6) ( див. част.2 рис. 3.15). 

Копіювання матеріалу. Для копіювання матеріалу на тому ж треку (рис.4.23) потрібно спочатку 

виділити його елементом (2) Select Tool (рис.4.2) і скопіювати клавішами Ctrl +C клавіатури в буфер. Потім 

потрібно встановити курсор вікна в потрібний такт і вставити інформацію CTRL+V. 

 
             Рис.4.23. Копіювання в межах трека 

 

Для копіювання на наступний трек потрібно скопіювати матеріал (Ctrl+C) або командою Copy 

Special меню Edit головного вікна, кликнути по рядку Paste Special меню Edit. У вікні, що відкрилося 

(рис.4.24) в полі Repetitions встановити необхідну кількість копій, в полі Starting Track вибрати трек для 

установки копії і підтвердити дії "ОК". На рис.4.25 показаний результат. 
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Рис.4.24. Вікно вибору установок копіювання                      Рис.4.25. Копіювання з треку на трек 

 

5. Режим відбитків клавіш (Piano Roll). Режим Piano Roll, у подальшому позначається 

абревіатурою PR, застосовується для введення своєрідних нот уручну музикантами, які не володіють 

навиками гри на MIDI-клавіатурі або синтезаторі, або для коригування написаного матеріалу. Для входу в 

режим потрібно в меню View головного вікна вибрати рядок Piano Roll View або скористатися "гарячими 

клавішами" Alt+3. Відкриється вікно рис.5.1. 

На горизонтальній лінійці вгорі відображаються такти і частки. Зліва горизонтально розташована 

фортепіанна клавіатура, на якій позначені розташування ноти До (С) різних октав. Всього комп'ютерних 

октав 10. П'ята комп'ютерна октава від ноти С5 відповідає першій класичній октаві, тобто С1, хоча в різних 

програмах зустрічаються виключення де С4 комп'ютерна відповідає С1 класичної. Музична інформація 

вводиться у вигляді прямокутників, ширина яких відповідає тривалості нот, а по вертикалі кожний 

прямокутник прив'язаний до відповідної клавіші клавіатури (рис.5.2). На малюнку введений звукоряд в 

п'ятій октаві. 

 

 
         Рис.5.1. Режим Piano Roll      Рис.5.2. Звукоряд в п'ятій октаві Piano Roll 

 

Для роботи в режимі застосовується та ж інструментальна панель, як і в попередніх режимах (рис. 

4.2). До введення нот потрібно вибрати її тривалість елементом 8 і прив'язку до ритмічної сітки елементом 9. 

●  Ноти можна вводити різними способами. Можна вибрати елемент 1 (Smart) в панелі 

управління або за допомогою F5 а потім утримуючи клавішу Alt натискувати на осередок 

сітки (рис.5.2). Залежно від місця натиснення на прямокутник виконуватимуться різні дії: 

 
● Лівий край. Установка початку ноти. 

● Правий край. Установка закінчення ноти. 

● Верхній край. Установка velocity ноти. 

● Нижній край. Дозволяє перетягнути ноту в інший осередок. 

Можна ввести ноту елементом 5 (Draw Freehand - гаряча клавіша F9). Для того, щоб побачити 

Velocity потрібно перетягнути вгору нижню горизонтальну лінію вікна Piano Roll (рис.5.3). Установка рівня 

Velocity проводиться елементом Draw Free Hand (F9) інструментальної панелі (рия.4.2). 
Щоб побачити Velocity   потрібно ввійти в меню Notes вікна Piano Roll і позначити мишкою рядок 

Show Velocity on Active Track only (для активного треку), з'явиться зображення Velocity нот треку. Якщо в 
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меню Notes активувати рядок Show Velocity on Selected Notes only, то буде видно Velocity виділеної в 

даний момент ноти. 

Для прикладу сформоване крещендо звукоряду на рис.5.3. Внизу вікна на рис.5.3 показано 

контролер Velocity. Включається панель контролерів з меню View рядком Show/Hide Controller Pane 

(рис.5.4). 

 
Рис.5.3. Вигляд Velocity у вікні Piano Roll           Рис.5.4. Включення / відключення панелі контролерів 

 

Для зміни типу контролера достатньо клацнути мишкою по знаку + зліва від панелі Velocity і у вікні 

MIDI Event Type, що відкрилося, відкрити випадний список Value (рис.5.5). 

При відключенні рядка Show/Hide Controller Pane на рис.5.4 режим відбитків клавіш набуває 

вигляд рис.5.6. 

 
 

Рис.5. 5. Вибір контролера                             Рис.5.6. Режим відбитків клавіш без панелі контролерів 

 

Режим Show Vertical Gridlines (рис.5.4) служить для включення вертикальних ліній сітки, а режим 

Grid Resolution для вибору дозволу сітки (рис.5.7). 

При включенні Show / Hide Track Pane (рис.5.4) справа у вікні відбитків клавіш з'являється панель 

треків (рис.5.8). Кнопкою із зображенням замка вікно Piano Roll закривається для збереження результатів із 

зображенням нот відбитки клавіш вибраного трека зникають з поля зору, але не звуку. Решта кнопок 

зрозуміла з висловленого раніше. 
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Рис.5.7. Вибір дозволу сітки                                   Рис.5.8. Панель треків 

 

При включенні Show / Hide Track Pane (рис.5.4) справа у вікні відбитків клавіш з'являється панель 

треків (рис.5.8). Кнопкою із зображенням замка вікно Piano Roll закривається для збереження результатів із 

зображенням нот, відбитки клавіш вибраного треку зникають з поля зору, але не звуку. Решта кнопок 

зрозуміла з вище зазначеного. 

При вході в меню Notes (рис.5.2) відкриється вікно (рис.5.9). Активація рядку Show Notes робить 

видимим позначення нот (квадратиків) у вікні, відключення - не видимим. При виборі рядку Show Velocity 

on Selected Nootes only включаються видимі значення Velocity тільки для виділених нот. Рядком Show 

Velocity on Active Track only робляться видимими значення Velocity тільки активного треку. 

В меню Tracks (рис.5.10), можна відповідно вибрати всі треки, показати наступний трек, показати 

попередній трек, і показати всі треки. 

  
Рис.5.9. Меню Notes Piano Roll                               Рис.5.10. Вміст меню Tracks 

 

6. Режим цифрового аудіо запису. Цифровий аудіо-запис - один найважливіших аспектів 

створення музики. Це процес дублювання на аудіо доріжку звуку з мікрофону або музичного інструменту. 

6.1. Додавання аудіо-треку. Якщо необхідно почати роботу з аудіотреку нового проекту, то 

потрібно ввійти в меню File - New і у вікні New Project File, що відкрилося, в зразках (Template) вибрати 

новий проект (Blank Project). Буде створений порожній проект в який можна вставляти треки. Для 

здійснення аудіо-запису потрібно додати аудіо-трек. Робиться це двома способами. 

1 - спосіб. Необхідно ввійти в меню Insert і вибрати мишкою Audio Track, який і з'явиться в 

головному вікні. 2 - спосіб. Клацнути правою кнопкою мишки на панелі Track і у випадному списку 

(рис.6.1) вибрати Insert Audio Track. 

 
Рис.6.1. Випадний список для вибору аудіо треку 
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Далі слід перевести звукову карту в режим запису з мікрофону, підключити метроном, якщо аудіо 

запис проводитиметься з його участю, і налаштувати його параметри. Щоб перейти до установок метронома 

потрібно вибрати меню Edit ➔ Preferences ➔ Project ➔ Metronome. Відкрити установки метронома 

можна  також натискуючи  правою кнопкою мишки на кнопці  Playback Metronome on/off  або Record 

Metronome   on/0ff       в модулі Transport транспортної панелі управління. Настройки параметрів 

метронома детально описані в частині 2. п.4. 

Для запису звуку потрібно включити кнопку запису Record Enable на треку (забарвлена ТБ 

червоний колір) і натискувати кнопку Record в модулі Transport панелі управління (або гарячу клавішу R 

на  клавіатурі  комп'ютера).  Після  закінчення  запису  необхідно  натиснути  кнопку  Stop     або клавішу 

пропуск. 

 
 

Рис.6.2. Приклад записаного фрагмента 

 
Рис.6.3. Регулювання рівня гучності запису 

 

В процесі запису може виявитися, що запис або недостатньо гучний, або навпаки (рис.6.3), що 

видно із покажчиків гучності на треку. Необхідно відрегулювати гучність на відповідних модулях звукової 

карти. Найбільш якісне доведення проводитиметься в кінці роботи. Вид головного вікна з аудіо треком і 

записаним фрагментом показаний на рис.6.2. 

7. Панель Browser. За допомогою цієї панелі можна імпортувати в проект дані різних типів: аудіо- 

шаблони, плагіни інструментів та ефектів. Розташована панель у вгорі правій частині робочого вікна 

(рис.7.1). 

 
Рис.7.1. Панель Browser 
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Щоб відкрити або закрити панель потрібно ввійти в меню View і вибрати Browser або натискувати 

гарячу клавішу В. 

Вміст меню Media. Елементи меню: 1.Відкриває Media Browser. 2. Меню Browser. 3. Меню 

Content Location.  4. Згортає (розвертає) панель. 5.Опції згортання.  6. Приховує (відкриває) 

панель. 7. Перехід в  папку на рівень вище поточної. 8. Фільтр пошуку. 9. Відтворення 

(остановка). 10. Видалення вмісту. 11. Збереження вмісту. 

При клацанні по кнопці Sinth відкриється вікно рис.7.2. 

 
Рис.7.2. Вікно Sinth для роботи з програмними інструментами 

 

Елементи вікна: 1. Додавання інструменту. 2. Видалення  інструменту. 3. Опції вставки інструменту. 

4. Відкриття папки Synch Rack Browers. 5. Меню установок інструменту. 6. Звернути (розвернути) панель. 

7. Режими четвертування. 7. Приховати (відкрити) панель.8. Список інструментів. 9. Меню Synch 

Automation. 

Завантажені в Browser аудіо або MIDI- семпли зразки можна відразу прослуховувати кнопкою 9 

(рис.7.1) і при необхідності завантажити в трек, схопивши семпл мишею і перетягнувши на трек. 

8. Збереження результатів. Sonar Platinum дозволяє зберігати результати роботи різними 

способами. Для збереження результату потрібно в меню File вибрати Save As. Відкриється вікно (рис.8.1), в 

якому в списку Go to Folder необхідно вибрати Project Files. 

Далі необхідно відкрити список Save as type з різними форматами (рис.8.2). 

  
        Рис.8.1. Вікно збереження результатів                               Рис.8.2. Список Save as type 

 

Normal - стандартний формат збереження проектів. Слід мати на увазі, що в цьому форматі 

використовуються не аудіо-дані, а посилання на них, тобто на те місце жорсткого диска, де вони 

зберігаються. При перенесенні файлу на інший комп'ютер потрібно переносити і збережені аудіо дані, 

інакше вони не відкриються в програмі Sonar. Збережений файл проект матиме розширення CWP. 
Template - файли шаблонів, що використовуються для нових проектів. 

Cakewalke Bundle - використовується для експорту проектів при роботі з ними в інших 

комп'ютерах. Файли формату бережуть в собі всі ті аудіо дані, що відносяться до них, і тому мають великі 

розміри. Файли зберігаються з розширенням CWB. При відкритті цих файлів проводиться розпаковування 

їх аудіо даних і збереження їх в нову теку комп'ютера. 

MIDI - файли не містять аудіо-даних, тому при збереженні в цьому форматі все аудіо-дані будуть 

виключені з проекту. MIDI - файли можуть мати формати Fomat 0 або Format 1. Format 0 містить MIDI - 

події, поміщені на один трек. Format 1 містить - події різних треків. 

Riff MIDI Format - розпізнається деякими пристроями. 

8.1. Збереження проекту в режимі Wav. Якщо проект містить MIDI - дані, то для отримання аудіо 

звучання потрібно спочатку перевести їх в аудіо формат. Для цього потрібно спочатку створити аудіо трек 

виконавши операцію - меню Insert а Audio Track. Потім включити на ньому червону кнопку запису. 

При подальшому включенні кнопки запису на транспортній панелі (див. част. 2, рис.3.12) або 

кнопки R на клавіатурі комп'ютера буде записана на аудіо трек звукова інформація всіх треків. Всю решту 
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треків після цього потрібно або знищити, або відключити. При необхідності необхідно нормалізується 

звучання аудіо треку операцією меню Process ➔ Apply Effekt ➔ Normalise. 

Для отримання Wav файлу потрібно виділити аудіо трек і ввійти в меню File ➔ Export ➔ Audio.  

У вікні, що відкрилося, вибрати (або створити) папку, задати ім'я файлу, в списку Files type вибрати 

необхідний формат (в нашому випадку Wav (Microsoft) задати частоту семплування і точність 

перетворення та кнопкою Export завершити операцію. 

 
Рис.8.3. Вікно вибору формату файлу 

 

Наукова новизна роботи полягає в розширенні можливостей композиторів, аранжувальників, 

звукорежисерів і початківців музикантів при створенні музики за допомогою одного з наймогутніших 

сучасних музичних редакторів Cakewalk SONAR Platinum. Висновки. Даний програмний продукт має 

можливості виконання повного циклу із запису, збереження, обробки, редагування, відтворенню 

цифрового саунду та зведення музики та відео. Cakewalk SONAR Platinum підходить як для домашніх 

студій, так і для Project-студій та багатоканальних комерційних систем звукозапису. Музичний звуковий 

редактор СAKEWALK SONAR PLATINUM це одна з передових робочих цифрових аудіо-станцій, що 

пропонує передові технології для творчих експериментів у створенні музики. 
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